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Informações importantes 
ao usuário

Equipamentos de estado sólido têm características operacionais diferentes 
dos equipamentos eletromecânicos. Safety Guidelines for the Application, 
Installation and Maintenance of Solid State Controls (Publicação SGI-1.1, 
disponível no escritório de vendas local da Rockwell Automation ou on-line 
em http://www.literature.rockwellautomation.com) descreve algumas 
diferenças importantes entre equipamentos de estado sólido e equipamentos 
eletromecânicos com fiação permanente. Devido a esta diferença e aos 
diversos usos dos equipamentos de estado sólido, todas as pessoas 
responsáveis pela aplicação deste equipamento devem estar conscientes que 
a cada aplicação desejada deste equipamento é aceitável.

Em nenhum evento a Rockwell Automation, Inc. será responsável ou 
propensa por danos indiretos ou conseqüentes do uso ou aplicação deste 
equipamento.

Os exemplos e diagramas neste manual servem apenas para fins ilustrativos. 
Como muitas variáveis e especificações associadas com uma instalação 
particular, a Rockwell Automation, Inc. não pode aceitar responsabilidade ou 
obrigações sobre o uso real baseado nos exemplos e diagramas.

Nenhuma responsabilidade de patente é assumida pela Rockwell 
Automation, Inc. com respeito ao uso da informação, circuitos, equipamentos 
ou software descritos neste manual.

É proibida a reprodução total ou parcial do conteúdo deste manual sem 
permissão por escrito da Rockwell Automation, Inc.

Ao longo deste manual, quando necessário, são utilizadas observações para 
alertá-lo sobre considerações de segurança.

ADVERTÊNCIA Identifica as informações sobre práticas e circunstâncias que possam 
causar explosões em ambiente classificado, o qual pode conduzir a 
ferimentos pessoais ou morte, danos à propriedade ou perda 
econômica.

IMPORTANTE Identifica as informações que são críticas para uma aplicação 
bem-sucedida e para a compreensão do produto.

ATENÇÃO Identifica as informações sobre práticas ou circunstâncias que podem 
conduzir a ferimentos pessoais ou morte, danos à propriedade ou 
perda econômica. Atenções ajudam a identificar e evitar um risco e a 
reconhecer as conseqüências.

PERIGO DE 
CHOQUE

Etiquetas podem estar sobre ou dentro do equipamento (por exemplo, 
inversor ou motor) para alertar as pessoas que tensões perigosas 
podem estar presentes.

PERIGO DE 
QUEIMADURA

Etiquetas podem estar localizadas sobre ou dentro do equipamento 
(por exemplo, inversor ou motor) para alertar as pessoas que as 
superfícies podem alcançar temperaturas perigosas.
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Prefácio

Para comunicação com controladores, os produtos RSView Machine 
Edition são configurados com:

• RSLinx Enterprise para a maioria das redes Rockwell Automation 
ou

• KEPServer Enterprise para servidores RSView OLE. 

O servidor KEPServer OLE expande as opções de conectividade do 
CLP e do equipamento incorporando 26 drivers de comunicação para 
as plataformas PanelView Plus e PanelView Plus CE e mais de 
31 drivers de comunicação para o RSView Machine Edition 
executando na área de trabalho. 

Este guia exibirá como configurar os drivers KEPServer, 
especificamente drivers Modbus para aplicações RSView ME que 
operam em: 

• Terminais PanelView Plus CE,

• Terminais PanelView Plus,

• ou no ambiente Windows 2000/XP.

Usando os drivers KEPServer configurados em sua aplicação RSView 
ME, os terminais poderão se comunicar com equipamentos em uma 
rede Modbus. 

Tópicos abordados • Capítulo 1 Instalação do Software – Aborda a instalação do 
software para RSView Studio, RSView Enterprise, KEPServer 
Enterprise e o Firmware Upgrade Wizard. 

• Capítulo 2 Características gerais dos protocolos Modbus – 
Informa as características gerais do Protocolo Modbus 
mestre/escravo e cada um dos drivers KEPServer para os 
protocolos de comunicação Modbus.

• Capítulo 3 Configuração dos Drivers KEPServer para Modbus – 
Exibe como usar o software KEPServer Enterprise para 
configurar os drivers KEPServer para os protocolos Modbus. 
Para cada driver, será criado um canal, adicionado um 
equipamento e criado tags. O driver é salvo em um arquivo de 
projeto .pfe que será definido como o projeto padrão.

• Capítulo 4 Teste das Comunicações KEPServer – Exibe como usar 
o OLE Quick Client para testar as comunicações KEPServer para 
o driver e os tags criados no Capítulo 3.

• Capítulo 5 Disponibilização do Driver KEPServer e dos tags no 
RSView Studio – Exibe como criar um servidor de dados OLE no 
RSView Enterprise ou RSView Studio. O servidor permitirá o 
acesso ao driver KEPServer e aos tags do sua aplicação RSView 
ME.

• Capítulo 6 Instalação dos drivers KEPServer no terminal – Exibe 
como usar o Firmware Upgrade Wizard para instalar os drivers 
KEPServer nos terminais PanelView Plus/PanelView Plus CE.
7 Publicação 2711P-UM002B-PT-P – Março 2007



8        
• Capítulo 7 Compilação, descarregamento e execução da 
aplicação – Exibe como compilar um arquivo .mer em tempo de 
execução, como conectar seu terminal PanelView Plus/
PanelView Plus CE a uma rede Modbus, como descarregar o 
arquivo .mer no terminal e como executar a aplicação.

• Capítulo 8 Localização de falhas – Aborda os tipos comuns de 
erros que ocorrem durante o tempo de execução e como 
corrigir estes erros.

Especificações de software O software a seguir deve ser instalado na área de trabalho de 
desenvolvimento:

• RSView Studio 3.0 ou mais recente

• Software KEPServer Enterprise

• Firmware Upgrade Wizard

Recursos adicionais Caso deseje, consulte as fontes a seguir para obter informações 
adicionais:

• Ajuda on-line para o software KEPServer Enterprise

• Ajuda on-line para RSView Studio ou RSView Enterprise

• Manual do Usuário PanelView Plus, publicação nr. 2711P-UM001

Uma versão eletrônica do manual do usuário PanelView Plus está 
disponível no endereço: 

http://literature.rockwellautomation.com
Publicação 2711P-UM002B-PT-P – Março 2007



Capítulo 1

Instalação do software

Objetivos Para desenvolver aplicações RSView ME, configure os drivers 
KEPServer e use-os com aplicações que operam nos terminais 
PanelView Plus/PanelView Plus CE, o software a seguir deve ser 
carregado em seu computador de desenvolvimento: 

• RSView Studio para ME ou RSView Enterprise

• KEPServer Enterprise

• Firmware Upgrade Wizard

Consulte as informações de instalação fornecidas com o RSView 
Studio e KEPServer Enterprise quanto aos detalhes mais recentes 
sobre as especificações de instalação. 

Instale RSView Studio RSView Studio Enterprise ou RSView Studio para o software Machine 
Edition é instalado a partir de: 

• um CD ou 

• descarregado do website da Rockwell Software no endereço 
www.software.rockwell.com. 

O menu de instalação com instruções aparecerá ao inserir o CD em 
um computador ou é possível executar o setup.exe a partir do 
diretório raiz.

IMPORTANTE Um número de série registrado atual é necessário para 
descarregar o software a partir do website Rockwell Software.
9 Publicação 2711P-UM002B-PT-P – Março 2007



10        Instalação do software
Instale o KEPServer 
Enterprise

KEPServer Enterprise é usado para:

• configurar o driver KEPServer 

• criar tags

• testar as comunicações na área de trabalho. 

KEPServer Enterprise está incluso no RSView Studio e pode ser 
instalado a partir de:

• um CD ou 

• descarregado do website da Rockwell Software no endereço 
www.software.rockwell.com. 

KEPServer opera como um serviço e um ícone será exibido na barra 
de ferramentas. 

O software pode ser instalado executando o arquivo setup.exe a partir 
do CD ou da versão descarregada.

Firmware Upgrade Wizard O Firmware Upgrade Wizard é usado para instalar os drivers 
KEPServer e atualizar o firmware nos dispositivos a seguir:

• PanelView Plus

• PanelView Plus CE 

O Firmware Upgrade Wizard é instalado automaticamente com o 
RSView Studio.

Os arquivos Firmware Upgrade (FUP) com os drivers KEPServer estão 
disponíveis no endereço http://support.rockwellautomation.com na 
seção Downloads.

IMPORTANTE Um número de série registrado atual é necessário para 
descarregar o software a partir do website Rockwell Software.

IMPORTANTE Ao instalar o KEPServer Enterprise, certifique-se de selecionar 
os drivers Modbus se não estiver fazendo a instalação 
completa.
Publicação 2711P-UM002B-PT-P – Março 2007



Capítulo 2

Drivers Modbus KEPServer

Objetivos Este capítulo fornece as características gerais dos drivers MODBUS 
KEPServer disponíveis no software RSView Enterprise. 

• ModBus mestre/escravo

– ModBus serial (RTU)

– ModBus serial não solicitado

• Modbus ASCII

• Modbus/TCP

ModBus mestre/escravo Uma rede Modbus mestre/escravo fornece um protocolo para 
transferência de dados e programação com um único mestre RTU e 
até 247 dispositivos escravos. Uma rede Modbus conecta os 
dispositivos a um terminal de computador central ou controador para 
controle supervisor ou aquisição de dados. Até 247 nós podem ser 
conectados a taxas de dados de até 19.200 baud usando mídia como 
cabo de par trançado, linhas de telefone transportadoras comuns ou 
transmissão em microondas. Esta rede é geralmente usada em 
aplicação SCADA em áreas grandes como água/esgoto e a indústria de 
petróleo e gás.

ModBus serial (RTU) 

ModBus serial (RTU) é o protocolo para um mestre e inclui suporte 
RTS para modem de rádio. Os equipamentos compatíveis incluem:

• Equipamentos compatíveis com Modbus

• Computador de fluxo Elliott

• Inversor Magnetek GPD 515

• Computador de fluxo Omni

• Computador de Fluxo Daniel S500

• Medidor Dinâmico de Fluido (DFM) SFC3

• Instromet

ModBus serial não solicitado

ModBus serial não solicitado simula até 247 equipamentos Modbus 
escravos. Os equipamentos compatíveis incluem os equipamentos 
compatíveis com Modbus.
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12        Drivers Modbus KEPServer
Redes ModBus mestre/escravo 

Consulte o Capítulo 7 para obter informações sobre cabo.

PanelView Plus
(ModBus serial ou

Driver em série não solicitado)
Conversor RS-232/RS-485 (1)

Conexão direta

(1) 1761-NET-AIC ou similar

Controlador (mestre ou escravo)

Rede Mestre/Escravo (Terminais escravos múltiplos conectados a um controlador mestre)

Controlador mestre

(3) Equipamentos escravos PanelView Plus
Cada um usa um Driver ModBus serial não solicitado

RS-232/RS-485 
Conversores

RS-232/RS-485 
Conversores

Equipamento Modbus

RS-232/RS-485 
Conversores

RS-232/RS-485 
Conversores

Equipamento Modbus

RS-232/RS-485 
Conversores

Equipamento Modbus

PanelView Plus PanelView Plus PanelView Plus

(1) Equipamento mestre PanelView Plus
   Usa Driver Modbus em série

PanelView Plus

Conexão do modem

Modems

Controlador mestrePanelView Plus

PanelView Plus

(2) Equipamentos escravos ModBus PanelView Plus
Cada um usa Driver ModBus serial não solicitado
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Drivers Modbus KEPServer        13
Modbus ASCII O protocolo Modbus ASCII é usado geralmente para conexão com 
outros equipamentos ASCII compatíveis com o protocolo Modbus 
ASCII. O suporte KEPServer inclui:

• Equipamentos compatíveis com Modbus ASCII

• Computadores de fluxo usando endereçamento de registro 
Daniels/Omni/Elliott

Modbus/TCP Modbus/TCP é um protocolo de envio de mensagem Modbus na rede 
Ethernet TCP/IP e tem por objetivo supervisionar e controlar o 
equipamento de automação. O uso mais comum deste protocolo é a 
conexão de CLPs, módulo de E/S e conversor de protocolos na 
Ethernet a outros barramentos de campo simples ou redes de E/S. 

O driver Modbus/TCP KEPServer suporta os modelos de equipamento 
Modbus e Mailbox.

Modelo de Equipamento Modbus

O modelo de equipamento Modbus mais comum é quando o driver 
conecta-se a equipamentos físicos (ex. Modicon TSX Quantum, outros 
equipamentos Modbus compatíveis com Ethernet aberta) e atua como 
um dispositivo na rede com uma identificação equivalente ao 
endereço IP da máquina. O driver aceita qualquer comando não 
solicitado recebido e tenta processá-lo como se fosse outro CLP.

MailBox

O modelo Mailbox determina o modo com que as requisições não 
solicitadas são manipuladas. Ao definir um equipamento mailbox, o 
driver não atua como um CLP na rede (como descrito acima). Ao 
invés disto, ele age como uma área de armazenamento para todo e 
qualquer equipamento mailbox definido. Quando o driver recebe um 
comando não solicitado, o driver detecta o endereço IP de onde vem 
a mensagem e coloca os dados na área de armazenamento alocada no 
equipamento. Se a mensagem vier de um equipamento com um 
endereço IP que não foi definido como equipamento mailbox, a 
mensagem não é processada. Qualquer aplicação cliente que 
leia/grave neste tipo de equipamento, lê/grava na área de 
armazenamento contida no driver, não no equipamento físico.
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14        Drivers Modbus KEPServer
Consulte a instrução MSTR na documentação do Modicon para obter 
detalhes sobre o envio de requisições não solicitadas ao driver 
Modbus Ethernet.

Orientação para 
desenvolvimento de 
aplicações Modbus

A seção fornece orientação geral para criação e operação de 
aplicações Modbus nos terminais PanelView Plus/PanelView Plus CE.

Criar uma aplicação Modbus 

Compile, descarregue e opere uma aplicação Modbus 

PanelView Plus

Ethernet
Chave

PanelView Plus
Controlador mestre

PanelView Plus

Ethernet
Chave

Etapas gerais Descrição Referência

Etapa 1 Crie um arquivo de projeto .pfe no KEPServer 
Enterprise.

Capítulo 3

Etapa 2 Configure um driver KEPServer Modbus. 
Adicione um canal e um equipamento ao arquivo 
de projeto. 

Capítulo 3

Etapa 3 Insira os tags da aplicação. Capítulo 3

Etapa 4 Ajuste seu arquivo .pfe como o arquivo de 
projeto padrão.

Capítulo 3

Etapa 5 Teste as comunicações KEPServer para verificar 
seu arquivo de projeto e tags.

Capítulo 4

Etapa 6 Crie um Servidor de Dados OLE para 
disponibilizar seus tags no RSView Studio.

Capítulo 5

Etapas gerais Descrição Referência

Etapa 1 Crie um cartão de atualização de firmware que 
contenha o driver KEPWare e atualize o terminal.

Capítulo 6

Etapa 2 Compile a aplicação RSView .mer. Capítulo 7

Etapa 3 Descarregue no terminal o arquivo de tempo de 
execução .mer.

Capítulo 7

Etapa 4 Conecte o terminal à rede Modbus. Capítulo 7

Etapa 5 Opere a aplicação. Capítulo 7
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Capítulo 3

Configuração de Drivers KEPServer para 
Modbus

Objetivos Este capítulo exibe como usar o software KEPServer Enterprise para 
configurar os drivers do KEPServer para os protocolos Modbus 
incluindo Ethernet TCP/IP, RTU em série, série não solicitado e série 
ASCII. Veremos como: 

• criar um projeto (.pfe) para drivers

• ajustar o arquivo de projeto como o projeto padrão

Para cada driver Modbus em seu arquivo de projeto, iremos:

• adicionar um canal 

• adicionar um equipamento (ou controlador)

• criar tags 

Criar um arquivo de projeto A primeira coisa a fazer é criar o arquivo de projeto.

1. Clique duas vezes no ícone KEPServer Enterprise no Systray 
para abrir a janela de projeto padrão abaixo.
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2. Crie um novo arquivo de projeto KEPServer (.pfe). A partir do 
menu, selecione File>Save As e salve o projeto como um 
arquivo .pfe.

Selecione o arquivo de 
projeto (.pfe) padrão

As etapas nesta seção garantem que o arquivo de projeto correto seja 
usado em sua aplicação RSView Studio.

Quando o RSView Studio cria uma aplicação de tempo de execução e 
a aplicação contém servidor KEPware OLE, o RSView Studio 
consolidará o arquivo de projeto KEPware (.pfe) no arquivo de tempo 
de execução (.mer). O arquivo de projeto que o RSView Studio usa é 
definido pelo campo de projeto padrão na guia General do menu 
Tools>Options no KEPware Server Enterprise.

1. A partir da barra de Menu, selecione Tools>Options…

2. Na guia General, clique no botão  próximo à caixa de texto 
do Projeto padrão.

3. Selecione o arquivo .pfe desejado e clique no botão .

Deverá ser possível ver o seguinte:

DICA Esta pode não ser a configuração atual executando 
no KEPware Server Enterprise. Se estiver testando a 
aplicação em seu microcomputador, certifique-se de 
que o nome do projeto na barra de título do 
KEPware Server Enterprise corresponda ao campo 
padrão do Projeto.
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4. Clique no botão  e em OK para aceitar o novo projeto 
como o padrão.

Configure Drivers para os 
protocolos Modbus

Esta seção exibe como configurar os drivers KEPServer que permitirão 
que o terminal PanelView Plus/PanelView Plus CE comunique-se 
através da rede Modbus.

Adicione um canal

A primeira etapa na comunicação com qualquer equipamento usando 
o software KEPServer é criar um canal. Um canal descreve as 
propriedades de protocolo e de driver usadas para comunicação. 
Enquanto um canal único pode ser usado para comunicar-se com 
vários equipamentos, canais separados devem ser definidos para cada 
driver exclusivo a ser usado. Somente um arquivo de configuração de 
projeto pode operar por vez, mas ele pode conter vários canais e 
equipamentos.

Etapa 1 – Adicione um novo canal

Clique no ícone New Channel ou clique com o botão direito em 
qualquer local do painel esquerdo. Isto fará surgir o assistente de 
novo canal.

Etapa 2 – Insira o nome do canal

Insira um nome exclusivo para o canal.

DICA A configuração KEPServer não é arquivada com o 
arquivo backup da aplicação RSView Studio (.apa). Se 
for necessário reutilizar o arquivo de configuração do 
projeto em outro computador, copie e arquivo .pfe. 
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Etapa 3 – Selecione um driver de equipamento

Selecione um driver a partir da lista dropdown. A tabela abaixo lista o 
driver correto para cada protocolo Modbus.

Etapa 4 – Selecione um adaptador de rede (somente para Modbus/TCP)

A seleção de adaptador de rede à esquerda permite selecionar um 
cartão NIC específico com base no nome do NIC ou em seu endereço 
IP atribuído atualmente. A lista de NICs disponíveis incluirá cartões 
NIC exclusivos ou NICs que possuam vários endereços IP atribuídos a 
eles. Além disso, a seleção exibirá qualquer conexão WAN que possa 
estar ativa, como uma conexão dialup.

Pra o PanelView Plus/PanelView Plus CE, selecione Default e clique 
em Next. 

Etapa 5 – Insira as configurações de comunicação (não aplicável ao 
Modbus/TCP)

A caixa de diálogo New Channel – Communications, garante que a 
configuração do controlador Modicon corresponda a dos 
controladores e equipamentos escravos.
 

Para este protocolo: Selecione este driver:

Modbus/TCP Modbus Ethernet

ModBus RTU em série (Mestre) Modbus em série

Modbus em série não solicitado (escravo) Modbus em série não solicitado

Modbus ASCII Modbus ASCII em série

Parâmetro Seleções Recomendado

Bits de dados 5, 6, 7, 8 8

Bits de parada 1, 2 1

Paridade Nenhum, Par, Impar Par

Baud 300 a 256000 9600 ou 19200
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ModBus RTU em série

Modbus em série não solicitado 

Modbus ASCII
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Etapa 6 – Defina o Método de otimização como Solicitações de 
dados

A caixa de diálogo New Channel – Write Optimization define o 
método de otimização para solicitações de dados. Selecione a melhor 
otimização para sua aplicação e clique em Next. 

Para mais informações sobre as opções de otimização de leitura e de 
gravação do KEPServer consulte a ajuda on-line do Driver.

Aplica-se a todos os protocolos 
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Etapa 7 – Selecione o uso de soquete (Aplica-se apenas ao Modbus/TCP)

A caixa de diálogo New Channel – Socket Usage controla como o 
driver Modbus Ethernet usará os soquetes do Windows ao estabelecer 
a conexão com o dispositivo alvo. Para um dispositivo Modbus 
Ethernet habilitado normal, o modo de operação padrão para Use 
Multiple Sockets for device connection (selecionado) é projetado para 
oferecer o melhor desempenho do driver.

Normalmente, o driver Modbus Ethernet usará um soquete Windows 
para cada equipamento na rede. Ao usar uma nova conexão de 
soquete para cada equipamento, o driver Modbus Ethernet mantém 
esse soquete como uma conexão ativa. Normalmente, isto fornece um 
nível de desempenho muito alto, já que o driver não precisa 
reestabelecer uma conexão toda vez que for necessário ler ou gravar 
dados em um determinado equipamento. 

Para mais informações sobre o uso de Soquetes em uma aplicação de 
interface Modbus RTU, consulte a ajuda on-line.

Clique em Next.
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Etapa 8 – Visualize e verifique o resumo do canal

A caixa de diálogo New Channel – Summary fornece um resumo das 
configurações do novo canal. Verifique as configurações abaixo e 
clique em Finish.

Modbus/TCP

ModBus RTU em série 
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Etapa 9 – Salve o arquivo de projeto
A partir da barra de Menu, selecione File>Save ou clique no botão 

Save .

Adicione um equipamento

Agora que um novo canal está definido, é necessário adicionar um 
novo equipamento ao canal. Na maioria dos casos, a seleção das 
configurações padrões permitirá configurar e conectar rapidamente a 
um equipamento.

DICA O X vermelho próximo ao nome do canal 
desaparecerá quando um equipamento de destino 
for adicionado sob este driver.

Modbus em série não solicitado 

Modbus ASCII em série
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Etapa 1 – Adicione um equipamento

Adicione um equipamento clicando no hypertexto Click to add a 
device ou no ícone New Device. Isto fará surgir o assistente de novo 
equipamento. Aqui será adicionada a informação pertinente ao 
controlador com o qual irá se comunicar.

Etapa 2 – Insira o nome do equipamento

Na caixa de diálogo New Device – Name, insira um nome para o 
equipamento que ajudará a identificar o equipamento posteriormente 
e clique em Next. Na maioria dos casos, o equipamento será um 
controlador lógico.

Etapa 3 – Selecione um modelo de equipamento

Se o equipamento que estiver definindo for compatível com mais de 
um modelo, selecione um modelo que melhor descreva o 
equipamento.

Para este protocolo: Modelo mais comum:

MODBIS/TCP Modbus

ModBus RTU em série Modbus

Modbus em série não solicitado Não aplicável

Modbus ASCII Modbus ASCII 
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Etapa 4 – Selecione uma identificação de equipamento

O equipamento que você está definindo pode ser multiponto como 
parte de uma rede de equipamentos. Para comunicar-se com o 
equipamento, ele deve ser atribuído a uma única identificação. 

Na caixa de diálogo New Device – ID, insira uma identificação de 
equipamento (endereço decimal) exclusiva para identificar o 
controlador na rede. Insira a identificação do equipamento e clique 
em Next.

Etapa 5 – Insira os parâmetros para comunicação com o 
equipamento (Não aplicável ao Protocolo Modbus em série não solicitado)

Na caixa de diálogo New Device – Communication Parameters, aceite 
os parâmetros de comunicação padrão clicando em Next.

Para este protocolo: Faixa de identificação 
de equipamento

Formato de 
dados

Modbus/TCP (1)

(1) Para comunicações mestre/escravo adicione um quinto octeto ao endereço IP. Consulte a 
documentação para seu KEPWare para mais detalhes sobre as comunicações Modbus/TCP 
mestre/escravo.

xxx.xxx.xxx.xxx Endereço IP

ModBus RTU em série 0 – 255 Decimal

Modbus em série não solicitado 1 – 247 Decimal

Modbus ASCII 1 – 247 Decimal
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Etapa 6 – Configure as opções de banco de dados de tag 
(Não aplicável aos Protocolos ASCII em série não solicitados)

Na caixa de diálogo New Device – Database Creation, clique em Next 
para aceitar as opções de configuração de banco de dados de tag 
padrões. 

As funções de geração de banco de dados tag OPC automática do 
servidor foram projetadas para tornar a configuração de sua aplicação 
OLE uma operação Plug and Play. Para drivers de comunicação que 
suportam esta funcionalidade, é possível configurá-los para construir 
automaticamente uma lista de tags OLE junto ao servidor que 
corresponda aos dados específicos do equipamento. Os tags OLE 
gerados automaticamente podem então ser navegados a partir de seu 
cliente OLE.
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Etapa 7 – Insira as configurações do equipamento 

Na caixa de diálogo New Device – Settings, aceite as configurações 
padrões clicando em Next

Modbus/TCP

ModBus RTU em série 
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Etapa 8 – Defina o tamanho do bloco para dados da leitura a partir do 
equipamento (Não aplicável ao Protocolo em série não solicitado)

A caixa de diálogo New Device – Block Sizes define o maior tamanho 
de bloco para leitura de E/S (bobinas) e tabelas de dados (Registros). 
Clique em Next.

Modbus em série não solicitado e Modbus ASCII

Modbus/TCP, Modbus RTU em série, Modbus ASCII
Publicação 2711P-UM002B-PT-P – Março 2007



Configuração de Drivers KEPServer para Modbus        29
Os motivos para alterar o tamanho de bloco padrão incluem:

• O equipamento pode não suportar operações de 
leitura/gravação de bloco do tamanho padrão. CLPs de 
Modicon menor e equipamentos que não sejam Modicon 
podem não suportar os comprimentos máximos de 
transferência de dados compatíveis com a rede Modbus 
Ethernet.

• O equipamento pode conter endereços não contíguos. Se for 
este o caso e o driver tentar ler um bloco de dados que inclui 
memória não definida, o equipamento provavelmente 
rejeitará a solicitação.

Etapa 9 – Defina o ponto de referência do arquivo de importação de 
variável

A caixa de diálogo New Device – Variable Import Settings define o 
ponto de referência do arquivo de importação de variável Concept ou 
ProWORX que o driver usará quando a função de geração automática 
de banco de dados de tag for habilitada para este equipamento. 
Consulte a ajuda on-line do KEPServer Enterprise para obter detalhes 
sobre como usar esta função. 
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Etapa 10 – Visualize e verifique as informações de resumo do 
equipamento

A caixa de diálogo New Device – Summary fornece um resumo das 
configurações do novo equipamento. Verifique as informações e 
clique em Finish.

Modbus/TCP

ModBus RTU em série
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Etapa 11 – Salve o arquivo de projeto
A partir da barra de Menu, selecione File>Save ou clique no botão 

Save .

Modbus em série não solicitado

Modbus ASCII
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Criar tag Com um canal e um equipamento definidos, podemos criar tags junto 
ao software KEPServer. Estes tags são usados para conexão com os 
endereços do controlador. O procedimento é semelhante à criação do 
banco de tag IHM. Para detalhes sobre os tipos de dados válidos e 
endereçamento, consulte Apêndices A – E.

1. No painel direito, clique no texto Click to add a static tag. 

Ou clique com o botão direito em um equipamento (como o 
Momentum_IEC) no painel esquerdo e selecione New Tag…

A caixa de diálogo Tag Properties abre.

2. Insira o nome e o endereço do tag juntamente com uma 
descrição como exibido nas caixas de diálogo a seguir. 

DICA Clique em ? próximo ao campo Address para 
ver uma lista de endereços válidos.
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O KEPServer permite validar o endereço com base no equipamento 
com o qual será feita a comunicação. Sua configuração de projeto 
deve agora listar as tags no painel direito.

3. A partir da barra de Menu, selecione File>Save ou clique no 

botão Save .

Substitua o ’xx pelo seu número de 
tabela. Por exemplo, Address para a 
tabela #1 seria 40101.
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Capítulo 4

Teste de comunicações do KEPServer

Objetivos Este capítulo exibe como testar as comunicações KEPServer em um 
computador de desenvolvimento para verificar sua configuração de 
projeto e tags.

Use o OPC Quick Client Incluso na instalação do servidor KEPServer trata-se de uma simples 
ferramenta para teste de tags OLE chamada OPC Quick Client. Ao 
criar uma nova configuração KEPServer, há vários tags de sistema e de 
comunicações que também são criados. Nesta seção, será verificada a 
comunicação com os tags que foram criados antes de incorporá-los a 
um projeto IHM.

1. Selecione Tools>Launch OPC Quick Client a partir do menu 

principal. Ou clique no ícone OPC Quick Client .

2. Destaque o nome do equipamento que deseja testar no painel 
esquerdo. Isto exibirá os tags que foram criados no painel 
direito.

3. Clique com o botão direito no tag que deseja testar no painel 
direito e selecione Synchronous Write.
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A janela resultante permite gravar novos dados no controlador e 
também exibe o valor atual do tag.
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Disponibilização de drivers e tags KEPServer 
no RSView Studio

Objetivos Agora que as comunicações KEPServer foram configuradas e testadas, 
pode-se disponibilizar o driver e tags do KEPServer no RSView Studio. 
Este capítulo exibirá como adicionar um servidor de dados OLE ao 
projeto RSView Studio. 

Crie um Servidor de Dados 
OLE

KEPServer é um servidor de dados OLE. É necessário adicionar este 
servidor ao projeto RSView Studio.

1. Abra o RSView Enterprise ou RSView Studio para o Machine 
Edition a partir do computador de desenvolvimento.

2. Abra sua aplicação.

3. No painel Application Explorer (esquerdo), clique no nome da 
aplicação na raiz da visualização de árvore e selecione 
New Data Server>OPC…

4. Clique no botão  próximo à caixa de texto OPC 
Server Name.
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5. Selecione KEPServerEnterprise e clique em OK.

6. Insira um nome para o driver KEPServer e clique em OK.
 

Mensagens informativas aparecem na parte inferior da janela do 
RSView Studio indicando que o servidor foi inicializado e está 
disponível no computador.

Qualquer tag criado anteriormente no software KEPServer está agora 
disponível para IHM usando o navegador de tag padrão RSView 
Studio. 

DICA Remova todos os driver seriais da Configuração de 
comunicação RSLinx Enterprise que entrariam em conflito com 
a porta configurada para Modbus.
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Navegue pelos tags 
KEPServer

1. Clique duas vezes ou clique com o botão direito sobre um 
objeto para abrir sua caixa de diálogo de propriedades.

2. Na guia Connections, clique no botão Value’s  para abrir o 
navegador de tag FactoryTalk.

3. Clique com o botão direito no cabeçalho no painel esquerdo e 
selecione Refresh All Folders para obter uma lista de tags no 
servidor de dados KEPServer.

4. Mova para baixo e selecione os tags da pasta que foi criada.

5. Clique em OK para fechar a janela.

DICA Para informações adicionais sobre o trabalho tags, consulte o 
Capítulo 6 do Guia do Usuário RSView Machine Edition 
(ViewME-UM003) disponível no menu de ajuda do RSView 
Studio.

Este é o nome do canal 
criado no KEPServer.

Este é o nome do equipamento 
criado no KEPServer.
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Capítulo 6

Instalação de drivers KEPServer no terminal

Objetivos Se planeja operar o projeto Machine Edition em um terminal 
PanelView Plus ou PanelView Plus CE, os componentes KEPServer de 
base CE correspondentes devem ser instalados. Este capítulo exibirá 
como usar o utilitário Firmware Upgrade Wizard (FUW) para instalar 
os drivers KEPServer nos terminais. 

Firmware Upgrade Wizard O Firmware Upgrade Wizard (FUW) adicionar os componentes 
KEPServer necessários para o firmware do terminal. É possível:

• criar um cartão de atualização de firmware (cartão compact 
flash) que será então carregado no slot de cartão do terminal 
para atualizar o firmware.

• atualizar o firmware em um terminal que está conectado ao seu 
computador da área de trabalho usando uma rede Serial, 
Ethernet ou conexão de rede via RSLinx Enterprise (para os 
protocolos compatíveis).

O Firmware Upgrade Wizard está disponível no RSView Studio. 
Consulte a Ajuda FUW para obter informações adicionais.

Preparação do terminal para atualização do firmware

Antes de iniciar o Firmware Upgrade Wizard, siga as etapas abaixo 
para preparar o terminal para uma atualização bem-sucedida.

1. Faça backup de todos os arquivos .MER no terminal em um 
cartão de armazenamento externo ou uma rede.

2. Apague todas as aplicações no terminal.

3. Grave qualquer configuração de comunicação Ethernet, como 
endereço IP, máscaras de subrede e gateways seleccionando 
Terminal Settings>Network e Communications>Network 
Connections>Network Adapters>IP Address.

4. Desabilite a função Auto-start no terminal selecionando Startup 
Options>RSView ME Station Startup e selecione Go to 
Configuration Mode.

5. Reinicialize o terminal.
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Copie os arquivos FUP para 
o computador de 
desenvolvimento

Descarregue os arquivos do Firmware Upgrade (FUP) com os drivers 
KEPServer para seu computador de desenvolvimento antes de usar o 
FUW. 

Os arquivos FUP estão disponíveis no Kit de mídia do Firmware 
Upgrade (Cód. cat. 2711P-RU31O) que pode ser pedido através de seu 
distribuidor Allen-Bradley local. Execute o arquivo *.exe para 
descompactar os arquivos. Descompacte os arquivos para este 
diretório:

Documents and Settings\All User Documents\RSView Enterprise\ME\Firmware Upgrade

Atualização de Firmware 
usando um cartão Compact 
Flash

Esta seção exibe como atualizar o firmware em um terminal 
PanelView Plus usando um cartão Compact Flash. É um processo de 
duas etapas. Primeiro, crie um cartão de atualização de firmware com 
os arquivos de firmware necessários. Segundo, carregue este cartão 
no terminal para atualizar o firmware.

1. Criação de um cartão de atualização de firmware

1. Inicie o Firmware Upgrade Wizard Selecione Start>Rockwell 
Software>RSView Enterprise>Firmware Upgrade Wizard.

2. Selecione Create firmware upgrade card.

• Na caixa de texto Firmware card location, selecione o destino 
para os arquivos compact flash (pasta no disco rígido ou local 
físico do cartão compact flash, ex., E:\). 

• A partir da lista Existing terminal, selecione o tipo de terminal 
PanelView Plus a ser atualizado e pressione Next.

DICA O Firmware Upgrade Wizard está disponível em 
http://.support.rockwellautomation.com em Downloads.

DICA Para adicionar um driver KEPWare a um terminal 
PanelView Plus 400/600, use um cartão compact flash.
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3. A partir da lista de pasta Firmware source, selecione o local dos 
arquivos firmware. O local padrão é C:\Program Files\Rockwell 
Software\RSView Enterprise\FUPs. 

A partir da lista Upgrade firmware version, selecione a versão do 
firmware que deseja atualizar e pressione Next.

4. Selecione os drivers KEPServer apropriados e pressione Next. 
Se o arquivo FUP selecionado não suportar drivers KEPServer, 
esta caixa de diálogo não aparecerá.

5. Selecione Finish para copiar os arquivos fonte de firmware para 
o local especificado na etapa 2.

IMPORTANTE Cada driver consome 150 Kbytes a 250 Kbytes de espaço de 
memória disk-on-chip. Somente instale drivers a serem usados 
nos terminais Windows CE. É sempre possível adicionar outros 
drivers posteriormente, se necessário.

DICA Se os arquivos foram criados em uma pasta separada no 
disco rígido local, copie os arquivos para o diretório raiz 
do cartão flash card.
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2. Atualização do Firmware no terminal usando o cartão Firmware Upgrade

1. Insira o cartão compact flash na de cartão de um terminal 
PanelView Plus energizado. Uma caixa de diálogo aparece 
indicando que a atualização do firmware vai começar. 

2. Pressione Upgrade para começar a atualização de firmware. 

IMPORTANTE NÃO remova o cartão compact flash enquanto a atualização 
está em andamento.
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3. Se outros terminais PanelView Plus existirem na mesma rede 
Ethernet, o erro resultante pode exibir:

Erro ao registrar o nome na rede (pode ser duplicado). Alterar 
no Painel de controle do sistema e tentar novamente.

Ignorar este erro. Será corrigido durante a atualização. Pressione 
OK para reconhecer o erro e aguarde a reinicialização do 
terminal.

4. Em terminais de tela touch ou touchscreen, deve-se calibrar a 
touchscreen selecionando os indicadores nos quatro cantos da 
tela e pressionando o meio da tela quando solicitado.

5. Ignore a mensagem a seguir, se ela surgir. Significa que o 
RSView ME está sendo instalado. Não toque nos dois botões que 
aparecem nesta mensagem.

Machine edition pode estar corrompido. Deseja descarregar o 
firmware?

6. Quando a atualização estiver concluída, uma caixa de diálogo 
aparece solicitando que remova o cartão compact flash da do 
cartão. Remova o cartão e pressione F8 ou Exit para reiniciar o 
terminal.

7. Configurações de comunicação são apagadas quando o terminal 
é atualizado. Se as comunicações Ethernet forem usadas, 
reconfigure os ajustes de comunicação Ethernet usando os 
valores gravados na preparação do terminal. 

8. Substitua os arquivos .MER para os quais fez back up antes de 
iniciar a atualização ou descarregar um novo arquivo .MER no 
terminal.

9. Carregue o arquivo .MER e execute o projeto.

DICA Se um mouse USB estiver disponível, é possível 
reconhecer este erro selecionando OK.

DICA Os drivers Kepware foram instalados no terminal. Nos 
terminais PanelView Plus CE, é possível ir para a pasta 
Storage Card/KEPServer/Drivers para verificar se o 
driver dll existe. 

DICA É possível configurar sua aplicação para iniciar 
automaticamente na inicialização em Startup Options.
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Atualização de firmware 
usando uma conexão de 
rede (Ethernet)

É possível atualizar o firmware em um terminal que está conectado ao 
seu computador da área de trabalho usando uma rede Serial, Ethernet 
ou conexão de rede (usando RSLinx Enterprise).

• Conexão de rede requer o RSLinx Enterprise onde é 
selecionado o terminal em uma rede existente. 

• Conexão serial requer uma conexão RAS configurada no 
computador. Durante a configuração RAS, a porta COM é 
selecionada. 

• Conexão Ethernet requer que seja inserido o Endereço IP do 
terminal. 

A conexão serial e a Ethernet requerem o utilitário PanelView Plus 
File Transfer executando no terminal e somente deve ser usado 
quando outros métodos falharem.

Esta seção exibe como atualizar o firmware em um terminal 
PanelView Plus usando uma conexão de rede via comunicações 
Ethernet.

1. Inicie o Firmware Upgrade Wizard Selecione Start>Rockwell 
Software>RSView Enterprise>Firmware Upgrade Wizard.
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2. Selecione Upgrade firmware no terminal e pressione OK.

3. Selecione Network connection e pressione Next.

Use as conexões Ethernet e Serial somente se a atualização do 
firmware não for bem sucedida.

4. Localize o terminal PanelView Plus em sua rede Ethernet por 
meio de seu endereço IP.

Vá para a Etapa 6 se encontrou o terminal. Se não localizar o 
terminal, clique com o botão direito no driver Ethernet e 
adicione o equipamento à árvore de navegação.
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5. Clique duas vezes em EthernetIP Devices. Selecione o terminal 
apropriado e pressione OK.

6. Insira o endereço IP para o terminal e pressione OK.

7. Selecione o terminal a ser atualizado e pressione OK.

PanelView Plus CE 1000
PanelView Plus CE 1250

PanelView Plus CE 700
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8. A partir da caixa de texto da pasta Firmware source, selecione o 
local dos arquivos firmware. O local padrão é C:\Program 
Files\Rockwell Software\RSView Enterprise\FUPs. 

A partir da lista Upgrade firmware version, selecione a versão do 
firmware que deseja atualizar e selecione Next.

9. Selecione os drivers KEPServer apropriados e selecione Next. Se 
o arquivo FUP selecionado não suportar drivers KEPServer, esta 
caixa de diálogo não aparecerá.

IMPORTANTE Cada driver consome 150 Kbytes a 250 Kbytes de espaço de 
memória disk-on-chip. Somente instale drivers a serem usados 
nos terminais Windows CE. É sempre possível adicionar outros 
drivers posteriormente, se necessário.

PanelView Plus 700
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10. Pressione Finish para iniciar a atualização.

11. Pressione Yes para continuar o processo de atualização. Se o 
terminal foi preparado corretamente para a atualização, nenhum 
aplicativo deverá estar executando.

12. Os arquivos de firmware são descarregados para o terminal. Isto 
pode levar até 15 minutos. Quando o download estiver 
completo, pressione OK para reinicializar o terminal. 

Se outros terminais PanelView Plus existirem na mesma rede 
Ethernet, o erro resultante pode exibir:

Erro ao registrar o nome na rede (pode ser duplicado). Alterar 
no Painel de controle do sistema e tentar novamente.

Ignorar este erro. Será corrigido durante a atualização. Pressione 
OK para reconhecer o erro e aguarde a reinicialização do 
terminal.

13. Em terminais de tela touch ou touchscreen, deve-se calibrar a 
touchscreen selecionando os indicadores nos quatro cantos da 
tela e pressionando o meio da tela quando solicitado.

DICA Se um mouse USB estiver disponível, é possível 
reconhecer o erro selecionando OK.
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14. Ignore a mensagem a seguir, se ela surgir. Significa que o 
RSView ME está sendo instalado. Não toque nos dois botões que 
aparecem nesta mensagem.

Machine edition pode estar corrompido. Deseja descarregar o 
firmware?

15. Configurações de comunicação são apagadas quando o terminal 
é atualizado. Se as comunicações Ethernet forem usadas, 
reconfigure os ajustes de comunicação Ethernet usando os 
valores gravados na preparação do terminal. 

16. Substitua os arquivos .MER para os quais fez back up antes de 
iniciar a atualização ou descarregar um novo arquivo .MER no 
terminal.

17. Carregue o arquivo .MER e execute o projeto.

DICA É possível configurar sua aplicação para iniciar 
automaticamente na inicialização em Startup Options.
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Capítulo 7

Compilação, download e execução da 
aplicação

Objetivos Este capítulo exibe como:

• compilar um arquivo de aplicação RSView ME em tempo de 
execução.

• descarregar e carregar a aplicação no terminal.

• conectar o terminal à rede Modbus.

• executar a aplicação.

Compilar um arquivo de 
aplicação em tempo de 
execução

Agora estamos prontos para construir o arquivo Machine Edition 
(.mer) em tempo de execução para ser descarregado em um terminal 
PanelView Plus/PanelView Plus CE. 

1. A partir da barra de Menu, selecione Application>Create 
Runtime Application…

2. Salve o projeto na pasta de Tempo de execução padrão no disco 

rígido. Insira o nome do arquivo e clique em 

Após alguns minutos, o projeto .mer deverá estar pronto para 
ser descarregado no terminal. O arquivo de projeto KEPServer 
.pfe criado no Capítulo 3 é integrado ao arquivo .mer. 

DICA Antes de compilar o arquivo .mer, verifique se o arquivo de 
projeto .pfe correto está selecionado. Consulte página 16.
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Descarregar a aplicação no 
terminal

Geralmente, descarregar uma aplicação a um terminal é realizado 
usando o utilitário de transferência de arquivo RSLinx Enterprise. É 
possível descarregar uma aplicação usando um cartão Compact Flash, 
uma conexão serial ou uma conexão Ethernet. Consulte o Manual do 
Usuário RSView Machine Edition (ViewME-UM003).

1. A partir da barra de Menu, selecione Tools>Transfer Utility…

2. Na guia Download, clique no botão .

3. Selecione o arquivo .mer e clique em 

Deverá ser possível ver a seguinte caixa de diálogo.

4. Selecione o PanelView Plus alvo usando a capacidade de 
navegação na Ethernet do RSLinx Enterprise. Clique com o 
botão direito em Ethernet, AB_ETH-1 driver e selecione Start 
Browsing.

5. Destaque seu terminal PanelView Plus ou PanelView Plus CE e 

clique em 
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6. Quando o download estiver completo, clique em  e 

observe o terminal.

7. Clique no botão Load Application [F1].

8. Selecione o arquivo .mer e clique no botão Load [F2]. 

9. Clique em Yes [F7] para substituir a configuração de 
comunicação atual RSLinx Enterprise do terminal pela 
armazenada no arquivo de aplicação. 

Carregar aplicação
 [F1] botão
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Conectar o terminal à rede 
Modbus

Antes de executar sua aplicação, é necessário conectar o terminal 
PanelView Plus/PanelView Plus CE a uma rede Modbus usando:

• Cabos seriais Modbus ou 

• Cabos Modbus Ethernet

Cabos seriais Modbus

A porta serial em um terminal PanelView Plus/PanelView Plus CE é 
diferente da porta de um computador. Geralmente, é necessário 
adicionar um adaptador nulo-modem a um cabo que trabalhe com um 
computador da área de trabalho. Para criar especificamente para o 
PanelView Plus/PanelView Plus CE, use as descrições de cabo nesta 
seção para os drivers Modbus Serial KEPServer (RTU Serial, Serial Não 
solicitado, ASCII Serial).

Porta terminal para controlador 9 pinos/25 pinos/8 pinos

Porta terminal para controlador com um RJ45

Porta PanelView Plus RS-232 
Controlador Modbus 
ou microcomputador 
na área de trabalho

MicroLogix/ DNI 

9 pinos DCE 9 pinos(1)

(1) Os cabos 2711-NC13, 2711-NC14 ou 2706-NC13 possuem um conector D-Shell de 9 pinos.

25 pinos 8 pinos DIN(2)

(2) Os 2711-NC21 ou 2711-NC22 possuem um conector Mini DIN de 8 pinos.

1
2 2 3 4

3 3 2 7

4 4 20

5 5 7 2

6 6 6

7 7 4

8 8 5

9
Conector Shell Aterramento do 

rack

RXD

TXD

DTR

COM

DSR

RTS

CTS

Terminal
DB-9 (macho)

Conector RJ-45
(macho)

2 RD
3 TD
5 SG

Proteção

1
2
3
4
5
7
6
8Blindagem
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Cabo nulo-modem

Para construir um cabo nulo-modem, consulte a pinagem a seguir:

Cabos Modbus Ethernet

A pinagem do conector RJ45 para o Terminal PanelView Plus ou 
VersaView é exibida abaixo.

Use comunicação ponto a ponto, cabos de base T 10/100 com 
pinagem cruzada (como 2711P-CBL-EX04) ao conectar a porta 
Ethernet no PanelView Plus diretamente à porta Ethernet do 
controlador ou à porta de Base T do computador 10/100. Use cabos 
Ethernet padrões ao conectar a um switch ou hub.

Terminal  Controlador

9 pinos  25 pinos 9 pinos

3 3 3

2 2 2

5 7 5

1 8 1

4 20 4

6 6 6

8 5 8

7 4 7

Conector Pino Nome do pino

Conector RJ45 1 TD+

2 TD-

3 RD+

4 NF

5 NF 

6 RD-

7 NF

8 NF

Conexão da 
blindagem

Aterramento do rack

1

8
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Executar a aplicação Agora que seu terminal PanelView Plus/PanelView Plus CE contém a 
aplicação carregada e está conectado à rede Modbus, é possível 
executar a aplicação. 

1. Clique no botão Run Application [F2] para iniciar a aplicação.

Carregar aplicação
 Botão [F2]
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Capítulo 8

Localização de falhas

Objetivos Este capítulo lista os erros comuns que ocorrem durante o 
desenvolvimento da aplicação assim como erros que ocorrem durante 
o tempo de execução. 

Para diagnosticar mensagens de erro que são geradas durante o 
desenvolvimento do driver KEPServer, consulte a ajuda on-line 
KEPServer quanto ao driver apropriado e consulte a descrição do erro.

Erros comuns Alguns dos erros mais comuns durante o desenvolvimento da 
aplicação estão listados abaixo:

• O arquivo .mer foi compilado com o arquivo .pfe errado. 
Consulte a página 16 para obter detalhes sobre a configuração 
do arquivo de projeto padrão. 

• O driver KEPServer não foi descarregado no terminal. Nos 
terminais PanelView Plus CE, é possível verificar que o driver 
está no cartão de armazenamento/KEPServer/pasta de drivers. 

• O cabo serial errado está conectado ao terminal PanelView Plus 
ou PanelView Plus CE. Consulte o Capítulo 7. 

Erros de tempo de 
execução

A tabela abaixo lista erros que podem ocorrer durante o tempo de 
execução. Causas possíveis e soluções são fornecidas para cada erro.

Erro Tipo de erro Causa possível Solução

O equipamento ’<nome do 
equipamento>’ não está 
respondendo

Grave 1. A conexão entre o equipamento e o terminal 
está partida.

2. Os parâmetros de comunicação para a 
conexão estão incorretos.

3. O equipamento nomeado pode ser sido 
atribuído a uma identificação de rede 
incorreta.

1. Verifique a cablagem entre o equipamento e 
o terminal. A pinagem serial para o terminal 
PanelView Plus/PanelView Plus CE é 
diferente da do computador.

2. Verifique se os parâmetros de comunicação 
especificados correspondem aos do 
equipamento.

3. Verifique se a identificação da rede 
informada para o equipamento corresponde 
ao equipamento correto.

Não é possível gravar no 
’<address>’ no equipamento 
’<device name>’

Grave 1. O equipamento informado pode não estar 
conectado à rede.

2. O equipamento nomeado pode ser sido 
atribuído a uma identificação de rede 
incorreta.

3. O equipamento informado não responde às 
solicitações de gravação.

4. O endereço não existe no CLP.

1. Verifique as conexões de rede do CLP.

2. Verifique se a identificação da rede 
informada para o equipamento corresponde 
ao equipamento correto.
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Endereço deficiente no bloco 
[x a y] no equipamento ’<nome 
do equipamento>’

Endereços 
fatais 
alocados 
neste bloco

Este erro é comunicado quando o driver tentar 
ler um local em um CLP que não existe. Por 
exemplo, em um CLP que possui apenas os 
registros de retenção 40001 a 41400, solicitar o 
endereço 41405 geraria este erro. Uma vez que o 
erro seja gerado, o driver não solicitará 
novamente o bloco de dados especificado do 
CLP. Qualquer outro endereço solicitado que 
esteja no mesmo bloco também será inválido.

Modifique a aplicação do cliente para solicitar 
endereços dentro de uma faixa do equipamento.

Comprimento deficiente 
recebido [x a y] no ’<nome do 
equipamento>’

Endereços 
fatais 
alocados 
neste bloco

O driver tenta ler um bloco de memória no CLP. O 
CLP responde com um erro, mão não fornece ao 
driver o tamanho de bloco de dados solicitado.

Certifique-se de que a faixa de memória existe 
para o CLP.

Erro Tipo de erro Causa possível Solução
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Apêndice A

Tipos de dados
Este apêndice descreve os tipos de dados válidos para criação de tags. 
Estas informações também estão disponíveis na ajuda on-line do 
sistema de acionamento Modbus em KEPServer Enterprise.

Tipos de dados Descrição(2)

(2) Não disponível para o protocolo Modbus ASCII.

Booleano Bit simples

Palavra Valor de 16 bits não atribuído
bit 0 é o bit baixo
bit 15 é o bit alto

Curto Valor de 16 bits atribuído
bit 0 é o bit baixo
bit 14 é o bit alto
bit 15 é o bit de sinal

Dword Valor de 32 bits não atribuído
bit 0 é o bit baixo
bit 31 é o bit alto

Longo Valor de 32 bits com sinal
bit 0 é o bit baixo
bit 30 é o bit alto
bit 31 é o bit de sinal

BCD BCD em pacote de dois bytes
Faixa de valor de 0 – 9999.
O comportamento é indefinido para valores além desta faixa.

LBCD BCD em pacote de quatro bytes
Faixa de valor de 0 – 99999999.
O comportamento é indefinido para valores além desta faixa.

Flutuante Valor de 32 bits de ponto flutuante
O sistema de acionamento interpreta dois registros 
consecutivos como um valor de ponto flutuante fazendo o 
segundo registrar a palavra alta e o primeiro registrar a 
palavra baixa.

Exemplo de flutuante: Se o registro 40001 for especificado 
como flutuante, o bit 0 do registro 40001 seria bit 0 de uma 
palavra de 32 bits e bit 15 do registro 40002 seria bit 31 de 
palavra de 32 bits.

Grupo(1)

(1) As descrições consideram o manuseio da primeira palavra de dados baixos do tipo de dados de 32 bits.

Grupo ASCII nulo terminado
Compatível com o Modelo Modbus, inclui a seleção de ordem 
de bit HILo LoHi.

Modbus em série
Dados de grupo de computador de fluxo Omni de 8 bytes e 
16 bytes
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Apêndice B

Definições do endereço Modbus/TCP

Este apêndice descreve o endereçamento de tag válido para as 
comunicações Modbus/TCP. Estas informações também estão 
disponíveis na ajuda on-line do sistema de acionamento Modbus/TCP 
em KEPServer Enterprise. Os sistemas de acionamento KEPServer 
usam endereçamento decimal.

Bobinas de saída

Exemplo: 
A bobina de saída 255° seria endereçada como ’0255’ usando o 
endereçamento decimal ’H0FF’ usando endereçamento hexadecimal.

Bobinas de entrada

Exemplo: 
A bobina de entrada 127° seria endereçada como ’1127’ usando o 
endereçamento decimal ’H17F’ usando endereçamento hexadecimal.

Bobinas de saída

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Booleano

Formato 0xxxxx H0yyyyy

Segurança Leitura/Gravação

Faixa 000001 – 065536 H000001 – H01000

Bobinas de entrada

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Booleano

Formato 1xxxxx H1yyyyy

Segurança Leitura(1)

(1) Para equipamento não solicitado 127.0.0.1.0, estes pontos de referência são Leitura/Gravação.

Faixa 100001 – 165536 H100001 – H11000
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Registros internos Os padrões são exibidos em negrito.

Vetores

Vetores também são compatíveis com os endereços de registro 
interno. A instrução para declaração de um vetor (usando o 
endereçamento decimal) é 3xxxx[cols] considerando a contagem de 
linha de 1 e 3xxxx[linhas][colunas].

Para vetores de Palavra, Curta e BCD, o endereço base + (linhas * 
colunas) não pode exceder 65536.

Para vetores de Flutuante, DWord, Longo e BCD Longo, o endereço 
base + (linhas * colunas * 2) não pode exceder 65535.

Para todos os vetores, o número total de registros solicitados não 
pode exceder o tamanho do bloqueio interno do registro que foi 
especificado neste equipamento.

Registros internos

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Palavra, Curta, BCD

Formato 3xxxxx H3yyyyy

Segurança Somente leitura(1)

(1) Para equipamento não solicitado 127.0.0.1.0, estes pontos de referência são Leitura/Gravação.

Faixa 300001 – 365536 H300001 – H31000

Tipo Booleano

Formato 3xxxxx.bb H3yyyyy.c

Segurança Somente leitura(1)

Faixa 3xxxxx.0 – 3xxxxx.15 3yyyyy.0 – 3yyyyy.F

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 3xxxxx H3yyyyy

Segurança Somente leitura(1)

Faixa 300001 – 365535 H3000D1 – H3FFFF
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Retenção de registros Os tipos padrões são exibidos em negrito. 

Retenção de registros

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Palavra, Curta, BCD

Formato 4xxxxx H4yyyyy

Segurança Leitura/Gravação

Faixa 400001 – 465536 H400001 – H410000

Tipo Booleano

Formato 4xxxxx.bb H4yyyyy.c

Segurança Leitura/Gravação

Faixa 4xxxxx.0 – 4xxxxx.15 4yyyyy.0 – 4yyyyy.F

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 4xxxxx H4yyyyy

Segurança Leitura/Gravação

Faixa 400001 – 465535 H400001 – H4FFFF

Tipo Ordem de byte de grupo 
HiLo

Formato 400001.2H – 465536.240H
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

H400001.2H – H4FFFF.240H
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

Segurança Leitura/Gravação

Faixa 400001 – 465536
Comprimento 2 – 240 bytes

H400001 – H4FFFF
Comprimento 2 – 240 bytes

Tipo Ordem de byte de grupo 
LoHi

Formato 400001.2L – 465536.240L
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

H400001.2L – H4FFFF.240L
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

Segurança Leitura/Gravação

Faixa 400001 – 465536,
Comprimento 2 – 240 bytes

H400001 – H4FFFF,
Comprimento 2 – 240 bytes
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Suporte para Grupo

O modelo Modbus suporta a leitura e gravação da memória de 
retenção de registro como um grupo ASCII. Ao usar registros de 
retenção para dados de grupos, cada registro conterá dois bytes de 
dados ASCII. A ordem dos dados ASCII de um determinado registro 
pode ser selecionada quando o grupo é definido. O comprimento do 
grupo pode ser de 2 a 240 bytes e é inserido no local de um número 
de bit. O comprimento deve ser inserido como um número par. A 
ordem de byte é especificada acrescentando um H ou L ao endereço.

Exemplo de grupo:
Para endereço um grupo que começa em 40200 com um 
comprimento de 100 bytes e uma ordem de byte HiLo insira: 

40200.100H 

Vetores

Vetores também são compatíveis com os endereços de registro de 
retenção. A instrução para declaração de um vetor (usando o 
endereçamento decimal) é 4xxxx[cols] considerando a contagem de 
linha de 1 e 4xxxx[linhas][colunas].

Para vetores de Palavra, Curta e BCD, o endereço base + (linhas * 
colunas) não pode exceder 65536.

Para vetores de Flutuante, DWord, Longo e BCD Longo, o endereço 
base + (linhas * colunas * 2) não pode exceder 65535.

Para todos os vetores, o número total de registros solicitados não 
pode exceder o tamanho do bloqueio do registro de retenção que foi 
especificado neste equipamento.
Publicação 2711P-UM002B-PT-P – Março 2007



Definições do endereço Modbus/TCP        67
Endereçamento de caixa de 
correio

Os tipos padrões são exibidos em negrito.

Vetores

Vetores também são compatíveis com os endereços de registro de 
retenção. A instrução para declaração de um vetor (usando o 
endereçamento decimal) é 4xxxx[cols] considerando a contagem de 
linha de 1 a 4xxxx[linhas][colunas].

Para vetores de Palavra, Curta e BCD, o endereço base + (linhas * 
colunas) não pode exceder 65536.

Para vetores de Flutuante, DWord, Longo e BCD Longo, o endereço 
base + (linhas * colunas * 2) não pode exceder 65535.

Para todos os vetores, o número total de registros solicitados não 
pode exceder o tamanho do bloqueio do registro de retenção que foi 
especificado neste equipamento.

Endereçamento de caixa de correio

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Palavra, Curta, BCD

Formato 4xxxxx H4yyyyy

Segurança Leitura/Gravação

Faixa 1 – 65536 1 – 10000

Tipo Booleano

Formato 4xxxxx.bb H4yyyyy.c

Segurança Leitura/Gravação

Faixa xxxxx.0 – xxxxx.15 yyyyy.0 – yyyyy.F

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 4xxxxx H4yyyy

Segurança Leitura/Gravação

Faixa 1 – 65535 1 – FFFF
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Endereçamento Instromet
Endereçamento decimal

Área Registros de palavra curta (16 Bits)

Tipo Palavra, Curta

Faixa 400000 – 400199

Segurança Somente leitura

Área Registros de palavra curta (32 Bits)

Tipo DWord, Longo

Faixa 400200 – 400399

Segurança Somente leitura 

Área Registros de ponto flutuante (32 Bits)

Tipo Flutuante

Faixa 400400 – 400599

Segurança Somente leitura 

DICA O endereçamento normal Instromet não inclui o 40xxx. Ele foi 
incluído aqui para manter os endereços em um modo 
compatível com Modbus normal.
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Apêndice C

Definições do endereço Modbus ASCII

Este apêndice descreve o endereçamento de tag válido para as 
comunicações Modbus ASCII. Estas informações também estão 
disponíveis na ajuda on-line do sistema de acionamento Modbus em 
KEPServer Enterprise. Os sistemas de acionamento KEPServer usam 
endereçamento decimal.

Bobinas de saída

Exemplo: 
A bobina de saída 255th seria endereçada como ’0255’ usando o 
endereçamento decimal ’H0FF’ usando endereçamento hexadecimal.

Bobinas de entrada

Exemplo: 
A bobina de entrada 127° seria endereçada como ’1127’ usando o 
endereçamento decimal ’H17F’ usando endereçamento hexadecimal.

Bobinas de saída

Endereçamento decimal

Tipo Booleano

Formato 0xxxxx

Segurança Leitura/Gravação

Faixa 000001 – 065535

Bobinas de entrada

Endereçamento decimal

Tipo Booleano

Formato 1xxxxx

Segurança Leitura(1)

(1) Para equipamento não solicitado 127.0.0.1.0, estes pontos de referência 
são Leitura/Gravação.

Faixa 100001 – 165535
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70        Definições do endereço Modbus ASCII
Registros internos Os padrões são exibidos em negrito.

Vetores

Vetores também são compatíveis com os endereços de registro interno 
e de retenção. A instrução para declaração de um vetor (usando o 
endereçamento decimal) é 3xxxx[cols] considerando a contagem de 
linha de 1 e 3xxxx[linhas][colunas].

Para vetores de Palavra, Curta e BCD, o endereço base + (linhas * 
colunas) não pode exceder 65536.

Para vetores de Flutuante, DWord, Longo e BCD Longo, o endereço 
base + (linhas * colunas * 2) não pode exceder 65535.

Para todos os vetores, o número total de registros solicitados não 
pode exceder o tamanho do bloqueio interno do registro que foi 
especificado neste equipamento.

Registros internos

Endereçamento decimal

Tipo Palavra, Curta, BCD

Formato 3xxxxx

Segurança Somente leitura(1)

(1) Para equipamento não solicitado 127.0.0.1.0, estes pontos de referência 
são Leitura/Gravação.

Faixa 300001 – 365535

Tipo Booleano

Formato 3xxxxx.bb

Segurança Somente leitura(1)

Faixa 3xxxxx.0 – 3xxxxx.15

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 3xxxxx

Segurança Somente leitura 

Faixa 300001 – 365534
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Definições do endereço Modbus ASCII        71
Retenção de registros Os tipos padrões são exibidos em negrito. 

Retenção de registros

Endereçamento decimal

Tipo Palavra, Curta, BCD

Formato 4xxxxx

Segurança Leitura/Gravação

Faixa 400001 – 465535

Tipo Booleano

Formato 4xxxxx.bb

Segurança Leitura/Gravação

Faixa 4xxxxx.0 – 4xxxxx.15

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 4xxxxx

Segurança Leitura/Gravação

Faixa 400001 – 465534
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72        Definições do endereço Modbus ASCII
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Apêndice D

Definições do endereço em série, não 
solicitado, Modbus

Este apêndice descreve o endereçamento de tag válido para as 
comunicações Modbus não solicitado ASCII. Estas informações 
também estão disponíveis na ajuda on-line do sistema de 
acionamento Modbus em KEPServer Enterprise. Os sistemas de 
acionamento KEPServer usam endereçamento decimal.

Bobinas de saída

Bobinas de entrada

Bobinas de saída

Endereçamento decimal

Tipo Booleano

Formato 0xxxxx

Segurança Leitura/Gravação

Faixa 000001 – 009999

Bobinas de entrada

Endereçamento decimal

Tipo Booleano

Formato 1xxxxx

Segurança Leitura

Faixa 100001 – 109999
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74        Definições do endereço em série, não solicitado, Modbus
Registros internos Os padrões são exibidos em negrito.

Vetores

Vetores também são compatíveis com os endereços de registro interno 
e de retenção. A instrução para declaração de um vetor (usando o 
endereçamento decimal) é 3xxxx[cols] considerando a contagem de 
linha de 1 e 3xxxx[linhas][colunas].

Para vetores de Palavra, Curta e BCD, o endereço base + (linhas * 
colunas) não pode exceder 65536.

Para vetores de Flutuante, DWord, Longo e BCD Longo, o endereço 
base + (linhas * colunas * 2) não pode exceder 65535.

Para todos os vetores, o número total de registros solicitados não 
pode exceder o tamanho do bloqueio interno do registro que foi 
especificado neste equipamento.

Registros internos

Endereçamento decimal

Tipo Palavra, Curta, BCD

Formato 3xxxxx

Segurança Somente leitura(1)

(1) Para equipamento não solicitado 127.0.0.1.0, estes pontos de referência 
são Leitura/Gravação.

Faixa 300000 – 309999

Tipo Booleano

Formato 3xxxxx.bb

Segurança Somente leitura(1)

Faixa 3xxxxx.0 – 3xxxxx.15

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 3xxxxx

Segurança Somente leitura(1)

Faixa 300001 – 309998
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Definições do endereço em série, não solicitado, Modbus        75
Retenção de registros Os tipos padrões são exibidos em negrito. 

Retenção de registros

Endereçamento decimal

Tipo Palavra, Curta, BCD

Formato 4xxxxx

Segurança Leitura/Gravação

Faixa 400001 – 409999

Tipo Booleano

Formato 4xxxxx.bb

Segurança Leitura/Gravação

Faixa 4xxxxx.0 – xxxxx.15

Tipo Flutuante, DWord, Longo, LBCD

Formato 4xxxxx

Segurança Leitura/Gravação

Faixa 400001 – 409998

Tipo Ordem de byte de grupo HiLo ou 
LoHi.

Formato 400001.2H – 409999.240H
.Bit tem comprimento de grupo,
Faixa de 2 – 240 bytes

Segurança Leitura/Gravação

Faixa 400001 – 409999
Comprimento 2 – 240 bytes
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76        Definições do endereço em série, não solicitado, Modbus
Suporte para Grupo

O modelo Modbus é compatível com a leitura e gravação da memória 
de retenção de registro como um grupo ASCII. Ao usar registros de 
retenção para dados de grupos, cada registro conterá dois bytes de 
dados ASCII. A ordem dos dados ASCII de um determinado registro 
pode ser selecionada quando o grupo é definido. O comprimento do 
grupo pode ser de 2 a 240 bytes e é inserido no local de um número 
de bit. O comprimento deve ser inserido como um número par. A 
ordem de byte é especificada acrescentando um H ou L ao endereço.

Exemplo de grupo:
Para endereço um grupo que começa em 40200 com um 
comprimento de 100 bytes e uma ordem de byte HiLo insira: 

40200.100H 
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Apêndice E

Definições do endereço em série Modbus 
(RTU)

Este apêndice descreve o endereçamento de tag válido para as 
comunicações em série Modbus (RTU). Estas informações também 
estão disponíveis na ajuda on-line do sistema de acionamento Modbus 
em KEPServer Enterprise. Os sistemas de acionamento KEPServer 
usam endereçamento decimal.

Bobinas de saída

Exemplo: 
A bobina de saída 255th seria endereçada como ’0255’ usando o 
endereçamento decimal ’H0FF’ usando endereçamento hexadecimal.

Bobinas de entrada

Exemplo: 
A bobina de entrada 127° seria endereçada como ’1127’ usando o 
endereçamento decimal ’H17F’ usando endereçamento hexadecimal.

Bobinas de saída (Códigos de função: 01, 05, 15)

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Booleano

Formato 0xxxxx H0yyyyy

Segurança Leitura/Gravação

Faixa 000001 – 065536 H000001 – H0FFFF

Bobinas de entrada (Código de função 02)

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Booleano

Formato 1xxxxx H1yyyyy

Segurança Leitura(1)

(1) Para equipamento não solicitado 127.0.0.1.0, estes pontos de referência são Leitura/Gravação.

Faixa 100001 – 165536 H100001 – H1FFFF
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78        Definições do endereço em série Modbus (RTU)
Registros internos Os padrões são exibidos em negrito.

Vetores

Vetores também são compatíveis com os endereços de registro 
interno. A instrução para declaração de um vetor (usando o 
endereçamento decimal) é 3xxxx[cols] considerando a contagem de 
linha de 1 e 3xxxx[linhas][colunas].

Para vetores de Palavra, Curta e BCD, o endereço base + (linhas * 
colunas) não pode exceder 65536.

Para vetores de Flutuante, DWord, Longo e BCD Longo, o endereço 
base + (linhas * colunas * 2) não pode exceder 65535.

Para todos os vetores, o número total de registros solicitados não 
pode exceder o tamanho do bloqueio interno do registro que foi 
especificado neste equipamento.

Registros Internos (Código de função 04)

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Palavra, Curta, BCD

Formato 3xxxxx H3yyyyy

Segurança Somente leitura(1)

(1) Para equipamento não solicitado 127.0.0.1.0, estes pontos de referência são Leitura/Gravação.

Faixa 300001 – 365536 H300001 – H310000

Tipo Booleano

Formato 3xxxxx.bb H3yyyyy.c

Segurança Somente leitura(1)

Faixa 3xxxxx.0 – 3xxxxx.15 H3yyyyy.0 – H3yyyyy.F

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 3xxxxx H3yyyy

Segurança Somente leitura(1)

Faixa 300001 – 365535 H300001 – H3FFFF
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Definições do endereço em série Modbus (RTU)        79
Retenção de registros Os tipos padrões são exibidos em negrito. 

Retenção de registros (Códigos de função: 03, 06(1), 16)

(1) Código de função 06 não pode ser usado com tipos de grupo.

Endereçamento decimal Endereçamento 
hexadecimal

Tipo Palavra, Curta, BCD

Formato 4xxxxx H4yyyyy

Segurança Leitura/Gravação

Faixa 400001 – 465536 H400001 – H41000

Tipo Booleano

Formato 4xxxxx.bb H4yyyyy.c

Segurança Leitura/Gravação

Faixa 4xxxxx.0 – 4xxxxx.15 H4yyyyy.0 – H4yyyyy.F

Tipo Flutuante, DWord, Longo, 
LBCD

Formato 4xxxxx H4yyyyy

Segurança Leitura/Gravação

Faixa 400001 – 465535 H400001 – H4FFFF

Tipo Ordem de byte de grupo 
HiLo

Formato 400001.2H – 465536.240H
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

H400001.2H – H4FFFF.240H
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

Segurança Leitura/Gravação

Faixa 400001 – 465536
Comprimento 2 – 240 bytes

H400001 – H4FFFF
Comprimento 2 – 240 bytes

Tipo Ordem de byte de grupo 
LoHi.

Formato 400001.2L – 465536.240L
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

H400001.2L – H4FFFF.240L
.Bit tem comprimento de 
grupo, 
Faixa de 2 – 240 bytes

Segurança Leitura/Gravação

Faixa 400001 – 465536,
Comprimento 2 – 240 bytes

H400001 – H4FFFF,
Comprimento 2 – 240 bytes
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80        Definições do endereço em série Modbus (RTU)
Suporte para Grupo

O modelo Modbus é compatível com a leitura e gravação da memória 
de retenção de registro como um grupo ASCII. Ao usar registros de 
retenção para dados de grupos, cada registro conterá dois bytes de 
dados ASCII. A ordem dos dados ASCII de um determinado registro 
pode ser selecionada quando o grupo é definido. O comprimento do 
grupo pode ser de 2 a 240 bytes e é inserido no local de um número 
de bit. O comprimento deve ser inserido como um número par. A 
ordem de byte é especificada acrescentando um H ou L ao endereço.

Exemplo de grupo 1:
Para endereço um grupo que começa em 40200 com um 
comprimento de 100 bytes e uma ordem de byte HiLo insira: 

40200.100H 

Exemplo de grupo 2:
Para endereçar um grupo que começa em 40500 com um 
comprimento de 78 bytes e uma ordem de byte LoHi, insira: 

40500.78L

Vetores

Vetores também são compatíveis com os endereços de registro de 
retenção. A instrução para declaração de um vetor (usando o 
endereçamento decimal) é 4xxxx[cols] considerando a contagem de 
linha de 1 e 4xxxx[linhas][colunas].

Para vetores de Palavra, Curta e BCD, o endereço base + (linhas * 
colunas) não pode exceder 65536.

Para vetores de Flutuante, DWord, Longo e BCD Longo, o endereço 
base + (linhas * colunas * 2) não pode exceder 65535.

Para todos os vetores, o número total de registros solicitados não 
pode exceder o tamanho do bloqueio do registro de retenção que foi 
especificado neste equipamento.
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Definições do endereço em série Modbus (RTU)        81
Descrições de endereço 
Magnetek 

A tabela a seguir fornece as faixas gerais de dados disponíveis para 
um Inversor Magnetek GPD 515. Consulte o Manual Técnico 
Magnetek Modbus RTU, código de catálogo TM4025, para obter 
informações sobre como acessar parâmetros específicos de inversor 
usando o endereçamento Modbus RTU. Em todos os casos, a letra H 
(usada para significar o endereçamento Hex) deve preceder o 
endereço desejado. 

Os tipos de dados padrões para tags definidos dinamicamente são 
exibidos em negrito, onde apropriado.

Exemplo de endereçamento 
Para acessar o Status de Operação do inversor (endereço 02BH), insira 
o endereço a seguir na aplicação de seu cliente.

H4002B

Observações importantes

• Ao adicionar um dispositivo Magnetek ao seu projeto de 
Servidor OLE, certifique-se de que Use Zero Based Addressing 
não esteja selecionado (página 27). Se este parâmetro não for 
ajustado corretamente, o sistema de acionamento Modbus RTU 
fará o offset de todos os seus endereços Magnetek por 1.

• Vetores são compatíveis com pontos de referência de registro de 
retenção para todos os tipos de dados exceto os booleanos. Há 
dois métodos de endereçamento de um vetor. Os exemplos são 
dados usando os pontos de referência de registro de retenção.

4xxx [linhas] [colunas]
4xxxx[cols] considerando que linhas seja igual a 1.

• Linhas multiplicadas por colunas não podem exceder o tamanho 
de bloqueio que foi atribuído ao dispositivo para o tipo de 
registro.

Endereçamento Magnetek GPD 515 – Formato Hexadecimal

Endereço Faixa Tipos de dados Acesso

Registros de comando H40001 – H4000F Palavra, Curta, booleano Leitura-Gravação

Acesso de nível de bit H4xxxx.0 – H4xxxx.F

Monitorar registros H40010 – H4001A Palavra, Curta, booleano Somente leitura

Acesso de nível de bit H4xxxx.0 – H4xxxx.F

Registros de parâmetro do 
sistema de acionamento 
(Somente Monitoração)

H40020 – H40097 Palavra, Curta, booleano Somente leitura

Acesso de nível de bit H4xxxx.0 – H4xxxx.F

Registros de parâmetro do 
sistema de acionamento

H401000 – H4050D Palavra, Curta, booleano Leitura/Gravação

Acesso de nível de bit H4xxxx.0 – H4xxxx.F

Registros especiais H44FFDD ACCEPT Palavra, Curta Somente gravação

H44FFDD ENTER
Publicação 2711P-UM002B-PT-P – Março 2007



82        Definições do endereço em série Modbus (RTU)
Descrições de endereço de 
computador de fluxo Elliott 

Os tipos de dados padrões para tags definidos dinamicamente são 
exibidos em negrito, onde apropriado.

Observações importantes

• Faixas de endereço 405001 a 405315 e 407001 a 407315 são 
registros de 32 bits. Endereços na faixa de 405001 a 405315 
usam um tipo de dado padrão Longo. Endereços na faixa de 
407001 a 407315 usam um tipo de dado padrão Flutuante. Uma 
vez que os registros deste endereço são de 32 bits, somente os 
tipos de dados Flutuante, DWord, Longo ou LBCD são 
permitidos. Vetores não são permitidos para estas faixas 
especiais de endereço. 

• Vetores são compatíveis com pontos de referência de registro de 
retenção e interno (veja a observação 1 quanto às exceções) 
para todos os tipos de dados exceto os booleanos. Há dois 
métodos de endereçamento de um vetor. Os exemplos são 
dados usando os pontos de referência de registro de retenção.

4xxxx [linhas] [colunas] 
4xxxx [cols] (este método considera que linhas seja igual a 1)

• Linhas multiplicadas por colunas não podem exceder o tamanho 
de bloqueio que foi atribuído ao dispositivo para o tipo de 
registro. Para vetores de tipos de dados de 32 bits, linhas 
multiplicadas por colunas multiplicado por 2 não podem 
exceder o tamanho de bloqueio.

Endereçamento de computador de fluxo Elliott

Endereço Faixa Tipos de dados Acesso

Bobinas de saída 000001 – 065536 Booleano Leitura-Gravação

Bobinas de entrada 100001 – 165536 Booleano Somente leitura

Registros internos 300001 – 365536
300001 – 365535
3xxxxx.0 – 3xxxxx.15

Palavra, Curta, Booleano
Flutuante, DWord, Longo, 
LBCD
Booleano

Somente leitura

Retenção de registros 400001 – 465536
400001 – 465535
4xxxxx.0 – 4xxxxx.15

Palavra, Curta, BCD (1)
Flutuante, DWord, Longo, 
LBCD 
Booleano

Leitura-Gravação
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Definições do endereço em série Modbus (RTU)        83
Descrições de endereço 
Omni 

Os tipos de dados padrões para tags definidos dinamicamente são 
exibidos em negrito, onde apropriado.

Endereçamento OMNI 

Endereço Faixa Tipos de dados Acesso

Ponto de E/S Digital 1001 – 1024 Booleano Leitura-Gravação

Ponto programável 
booleano

1025 – 1088 Booleano Leitura-Gravação

Status de operação do 
medidor e pontos de 
alarme

1n01 – 001n59
1n76 – 1n99
n = Número de execuções do medidor

Booleano Leitura-Gravação

Micro Motion 
Pontos de status de alarme

1n60 – 1n75
n = Número de execuções do medidor

Booleano Leitura-Gravação

Ilha de ranhura do usuário 
Pontos Booleanos

1501 – 1599
1601 – 1649

Booleano Leitura-Gravação

Ilha de ranhura do usuário 
Um
Pontos de disparo

1650 – 1699 Booleano Leitura/Gravação

Comando Booleano
Pontos/variáveis

1700 – 1798 Booleano Leitura/Gravação

Alarme da estação do 
medidor e
Pontos de status

1801 – 1899 Booleano Leitura/Gravação

Alarme do prover e 
Pontos de status

1901 – 1967 Booleano Leitura/Gravação

Totalizador do medidor 
Flags de transferência

2n01 – 2n37
n = Número de execuções do medidor

Booleano Leitura/Gravação

Misc. Estação do medidor
Alarme e Status

2601 – 2623 Booleano Leitura/Gravação

Totalizador da estação 
Flats de transferência

2801 – 2851 Booleano Leitura/Gravação

Totalizador da estação
Resolução decimal

2852 – 2862
2865 – 2999

Booleano Leitura/Gravação
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84        Definições do endereço em série Modbus (RTU)
Endereçamento OMNI – Endereços de dados inteiros de 16 Bits 

Endereço Faixa Tipos de dados Acesso

Dados customizados
Pacote #1

3001 – 3040 Curto, Palavra, BCD Leitura-Gravação

Dados customizados
Pacote #2

3041 – 3056 Curto, Palavra, BCD Leitura-Gravação

Dados customizados
Pacote #3

3057 – 3096 Curto, Palavra, BCD Leitura/Gravação

Misc. Dados inteiros de 
16 Bits

3097 – 3099
3737 – 3799
3875 – 3899

Curto, Palavra, BCD Leitura/Gravação

Operação do medidor 
16 Bits 
Dados inteiros

3n01 – 3n52
n = Número do medidor 

Curto, Palavra, BCD Leitura/Gravação

Scratchpad de 16 Bits
Dados inteiros

3501 – 3599 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #1 3601 – 3608 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #2 3609 – 3616 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #3 3617 – 3624 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #4 3625 – 3632 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #5 3633 – 3640 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #6 3641 – 3648 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #7 3649 – 3656 Curto, Palavra, BCD Leitura/Gravação

Tela do usuário #8 3657 – 3664 Curto, Palavra, BCD Leitura/Gravação

Dados brutos de acesso 
REgistros de arquivo

3701 – 3736 Curto, Palavra, BCD Leitura/Gravação

Estação do medidor 16 Bits
Dados inteiros

3800 – 3842 Curto, Palavra, BCD Leitura/Gravação

Sequência de batelada do 
medidor #1

3843 – 3848 Curto, Palavra, BCD Leitura/Gravação

Sequência de batelada do 
medidor #2

3849 – 3854 Curto, Palavra, BCD Leitura/Gravação

Sequência de batelada do 
medidor #3

3855 – 3860 Curto, Palavra, BCD Leitura/Gravação

Sequência de batelada do 
medidor #4

3861 – 3866 Curto, Palavra, BCD Leitura/Gravação

Data/Hora do computador 
de fluxo

3867 – 3874 Curto, Palavra, BCD Leitura/Gravação

Dados inteiros de 16 Bits 
do prover

3901 – 3999 Curto, Palavra, BCD Leitura/Gravação
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Definições do endereço em série Modbus (RTU)        85
Endereçamento OMNI – Dados de grupo ASCII de 8 caracteres

Endereço Faixa Tipos de dados Acesso

Dados ASCII de operação do medidor 4n01 – 4n39
n = Número de execuções do medidor

Grupo Leitura-Gravação

Dados ASCII Scratch Pad 4501 – 4599 Grupo Leitura-Gravação

Variáveis de definição da tela do 
usuário

4601 – 4640 Grupo Leitura/Gravação

Estação auxiliar
Variáveis de entrada

4707 – 4710 Grupo Leitura/Gravação

Estação do medidor
Dados ASCII

4801 – 4851 Grupo Leitura/Gravação

Operação do medidor 16 Bits 
Dados inteiros

4707 – 4710 Grupo Leitura/Gravação

Identificação da batelada medidor #1 4852 – 4863 Grupo Leitura/Gravação

Identificação da batelada medidor #2 4864 – 4875 Grupo Leitura/Gravação

Identificação da batelada medidor #3 4876 – 4887 Grupo Leitura/Gravação

Identificação da batelada medidor #4 4888 – 4899 Grupo Leitura/Gravação

Dados de grupo ASCII do prover 4901 – 4942 Grupo Leitura/Gravação

Endereçamento OMNI – Dados inteiros de 32 Bits

Endereço Faixa Tipos de dados Acesso

Operação do medidor 32 Bits 
Dados inteiros

5n01 – 5n99
n = Número de execuções do medidor

Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

ScratchPad de 32 Bits 
Dados inteiros 

5501 – 5599 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Dados inteiros de 32 Bits da estação 5801 – 5818 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Tamanho da batelada do medidor #1 5819 – 5824 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Tamanho da batelada do medidor #2 5825 – 5830 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Tamanho da batelada do medidor #3 5831 – 5836 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Tamanho da batelada do medidor #4 5837 – 5842 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Adicional de 32 Bits 
Dados de operação do medidor

5843 – 5899 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Dados inteiros de 32 Bits do prover 5901 – 5973 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Pulsos do Prover TDVOL/TDFMP 
Compacto

5974 – 5999 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação
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Endereçamento OMNI – Dados de ponto flutuante IEEE de 32 Bits

Endereço Faixa Tipos de dados Acesso

Dados reservados 6001 – 7000 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Saídas digitais para analógicas 7001 – 7024 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Variáveis do usuário 7025 – 7088 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Acumulador programável 7089 – 7099 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados de operação do medidor 7n01 – 7n99
n = Número de execuções 
do medidor

Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados Scratch Pad 7501 – 7599 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados de controle PID 7601 – 7623 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Miscelânea 
Dados de operação do medidor

7624 – 7699 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Variáveis diversas 7701 – 7799 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados da estação do medidor 7801 – 7899 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados do Prover 7901 – 7918 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados de configuração 
para Prover

7919 – 7958 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Últimos dados do prover 7959 – 7966 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados rejeitados durante 
comprovação

7967 – 7990 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados de operação de comprovação 7991 – 8050 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados médios de comprovação 8051 – 8079 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Operação de comprovação – Dados 
mestres do medidor

8080 – 8199 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados da série Proving 8200 – 8223 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Comprovação dos dados do medidor 8224 – 8230 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados de comprovação de massa 8231 – 8500 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Miscelânea 
Operação do medidor #1

8501 – 8599 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Miscelânea 
Operação do medidor #2

8601 – 8699 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Miscelânea 
Operação do medidor #3

8701 – 8799 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Miscelânea 
Operação do medidor #4

8801 – 8899 Flutuante, Longo, DWord, LBCD Leitura-Gravação

Dados médios prévios de batelada da 
estação

8901 – 8999 Flutuante, Longo, DWord, LBCD Leitura-Gravação
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Endereçamento OMNI – Dados de configuração inteiros de 16 Bits

Endereço Faixa Tipos de dados Acesso

Operação do medidor #1 13001 – 13013 Curto, Palavra, BCD Leitura-Gravação

Operação do medidor #2 13014 – 13026 Curto, Palavra, BCD Leitura-Gravação

Operação do medidor #3 13027 – 13039 Curto, Palavra, BCD Leitura-Gravação

Operação do medidor #4 13040 – 13052 Curto, Palavra, BCD Leitura-Gravação

Configuração do Prover 13053 – 13073 Curto, Palavra, BCD Leitura-Gravação

Configuração de fluxo 
geral

13074 – 13084 Curto, Palavra, BCD Leitura-Gravação

Configuração da porta 
serial

13085 – 13128 Curto, Palavra, BCD Leitura-Gravação

Configuração PID 13129 – 13160 Curto, Palavra, BCD Leitura-Gravação

Dados do CLP 13161 – 13299 Curto, Palavra, BCD Leitura-Gravação

Ajuste Peer to Peer 13300 – 13499 Curto, Palavra, BCD Leitura-Gravação

Arquivo de dados brutos 13500 – 13999 Curto, Palavra, BCD Leitura-Gravação

Endereçamento OMNI – Dados de grupo ASCII de 16 caracteres

Endereço Faixa Tipos de dados Acesso

Configuração do 
computador de fluxo

14001 – 14499 Grupo Leitura-Gravação

Endereçamento OMNI – Dados inteiros de 32 Bits

Endereço Faixa Tipos de dados Acesso

Configuração do 
computador de fluxo

15001 – 16999 Longo, DWord, LBCD, 
Flutuante

Leitura-Gravação

Endereçamento OMNI – Dados de ponto flutuante IEEE de 32 Bits

Endereço Faixa Tipos de dados Acesso

Configuração do 
computador de fluxo

17001 – 18999 Flutuante, Longo, DWord, 
LBCD

Leitura-Gravação
Publicação 2711P-UM002B-PT-P – Março 2007



88        Definições do endereço em série Modbus (RTU)
Descrições do endereço 
Daniel S500

Os tipos de dados padrões para tags definidos dinamicamente são 
exibidos em negrito, onde apropriado.

Endereçamento Daniel S500 

Endereço Faixa hexa Faixa decimal Tipos de dados Código de 
função

Acesso

Totais 000 – 0FF 4096 – 4351 Duplo 03 Somente leitura

Calculado/Medido
Variáveis

100 – 24F 4352 – 4687 Flutuante 03, 16 Leitura/Gravação

Consultores de cálculo 250 – 28F 4688 – 4751 Flutuante 03, 16 Leitura/Gravação

Valores padrões do teclado 290 – 2AF 4752 – 4783 Flutuante 03, 16 Leitura/Gravação

Alarme e conversão de 
escala
Constantes

2B0 – 5FF 4784 – 5631 Flutuante 03, 16 Leitura/Gravação

Status/Controle 700 – 7FF 5888 – 6143 Booleano 02, 5 Leitura/Gravação

Alarmes 800 – 8FF 6144 – 8191 Booleano 02 Leitura/Gravação
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Suporte da Rockwell 
Automation

A Rockwell Automation fornece informações técnicas na Web para auxiliar na 
utilização de seus produtos. No website http://support.rockwellautomation.com, 
você pode encontrar manuais técnicos, uma base de conhecimento de FAQs, 
notas técnicas e de aplicação, exemplos de código e links para service packs de 
software, bem como um recurso MySupport que você pode customizar para 
aproveitar melhor estas ferramentas.

Para um nível adicional de suporte técnico telefônico para instalação, 
configuração e localização de falhas, oferecemos os programas TechConnect 
Support. Para outras informações, entre em contato com o seu distribuidor local 
ou um representante da Rockwell Automation ou visite 
http://support.rockwellautomation.com.

Assistência à instalação

Caso tenha um problema com o módulo de hardware dentro das primeiras 
24 horas de instalação, revise as informações contidas neste manual. Também é 
possível contatar um número especial de Suporte ao Cliente para obter ajuda 
inicial para colocar o módulo em funcionamento:

Devolução de Satisfação de Novos Produtos

A Rockwell testa todos os seus produtos para assegurar que estejam totalmente 
em funcionamento ao serem enviados para as instalações de produção. 
Entretanto, caso o produto não esteja funcionando e precise ser devolvido:

PanelView Plus, VersaView, ControlLogix, TechConnect, RSView Studio, RSView Machine Edition, RSNetWorx 
for DeviceNet, RSLogix 5000, RSView, PLC-5, SLC, RSLinx, RSLinx Enterprise, RSNetWorx, Allen-Bradley e 
Rockwell Automation são marca comerciais da Rockwell Automation, Inc.

As marcas comerciais não pertencentes à Rockwell Automation são de propriedade de suas respectivas 
entradas.

Estados Unidos 1.440.646.3223
Segunda à sexta, das 8 às 17 h (costa leste)

Fora dos Estados 
Unidos da América

Entre em contato com seu representante local da Rockwell Automation 
para qualquer questão de suporte técnico.

Estados Unidos Entre em contato com seu distribuidor. Você deve fornecer um número de 
caso do Customer Support (consulte o telefone acima para obter um) 
para que o seu distribuidor conclua o processo de devolução.

Fora dos Estados 
Unidos da América

Entre em contato com seu representante local da Rockwell 
Automation para o processo de devolução.
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